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Getting Started Processing TDOA 
and FDOA Data with ODTK 

1 Introduction 

The Ansys Orbit Determination Tool Kit® (ODTK®) application can simulate and process numerous 

flavors of time difference of arrival (TDOA) and frequency difference of arrival (FDOA) measure-

ments. You can model these measurements in the following ways: 

• a single receiver processing a single signal that has been propagated along two different 

paths 

• two receivers processing a single signal 

• a single receiver processing two separate signals 

The specific types of measurements modeled in the ODTK application are listed in the table be-

low. The strand notation in the table describes the signal path: E (emitter), S (satellite/satellite-

based receiver), R (ground receiver), “-“ (sequential connection), and “,” (parallel connection). 
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Measurement Strand Description 

TDOA E-S,S-R A signal emitted from a single ground-based emitter 

travels through two relay satellites to a common 

ground-based receiver. 

FDOA E-S,S-R A signal emitted from a single ground-based emitter 

travels through two relay satellites to a common 

ground-based receiver. 

TDOA Dot E-S,S-R This is the time derivative of TDOA. 

SD TDOA E,E-S,S-R Signals emitted from two ground-based emitters 

travel through two relay satellites to a common 

ground-based receiver. This method cancels out most 

satellite-based errors and downlink errors. 

SD FDOA E,E-S,S-R Signals emitted from two ground-based emitters 

travel through two relay satellites to a common 

ground-based receiver. This method cancels out most 

satellite-based errors and downlink errors. 

TDOA 2 Receivers E-S,S-R,R A signal emitted from a single ground-based emitter 

travels through two relay satellites to two ground-

based receivers. 

FDOA 2 Receivers E-S,S-R,R A signal emitted from a single ground-based emitter 

travels through two relay satellites to two ground-

based receivers. 

TDOA 2 Emitters E,E-S-R Signals emitted from two ground-based emitters 

travel through a relay satellite to a single ground-

based receiver. 

FDOA 2 Emitters E,E-S-R Signals emitted from two ground-based emitters 

travel through a relay satellite to a single ground-

based receiver. 

TDOA Dot 2 Emitters E,E-S-R This is the time derivative of TDOA 2 Emitters. 

SB TDOA E-S,S A signal emitted from a single ground-based emitter 

travels to two satellite-based receivers. 

SB FDOA E-S,S A signal emitted from a single ground-based emitter 

travels to two satellite-based receivers. 

SB TDOA Dot E-S,S This is the time derivative of SB TDOA. 
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SB TDOA SBE E-S,S A signal emitted from a single space-based emitter 

travels to two satellite-based receivers. 

SB FDOA SBE E-S,S A signal emitted from a single space-based emitter 

travels to two satellite-based receivers. 

GroundTDOA E-R,R A signal emitted from a single space-based emitter 

travels to two ground-based receivers. 

GroundFDOA 

 

E-R,R A signal emitted from a single space-based emitter 

travels to two ground-based receivers. 

GroundFDOADot E-R,R This is the time derivative of GroundFDOA. 

 

In the following exercises, you will explore the TDOA, FDOA, SB TDOA, SB FDOA, SD TDOA, and 

SD FDOA measurement types. For TDOA and FDOA measurements, an emitted signal travels via 

relay satellites along two different routes to a common receiver, where the time of arrival (TOA) 

and the frequency of arrival (FOA) along each route are recorded. The difference in TOA between 

the two signal paths forms a TDOA measurement, and the difference in FOA between the two 

paths forms a FDOA measurement. TDOA and FDOA measurements can support orbit determina-

tion, geolocation of stationary Earth-fixed objects, or both. Operational use cases for TDOA and 

FDOA may use one emitter or two or more emitters simultaneously. 

In the ODTK application, a signal path begins at an immobile Earth-based emitter. The signal is 

relayed through a single satellite and ends at a ground-based receiver. TDOA and FDOA measure-

ments may exist when two satellites (signal paths) are concurrently visible to the emitter and its 

receiver. Time differences of signal reception are in the sense of Path 2 minus Path 1, where the 

time tag is relative to Path 1. For example, a positive TDOA observation indicates that the time of 

signal travel along Path 2 is longer than the time of signal travel along Path 1. The measurements 

may be tagged at the moment of ground receipt (TDOA/FDOA) or satellite receipt (SB TDOA/SB 

FDOA). If a measurement is tagged at "satellite-receipt" time, this implies that the effects of the 

satellite relay transponder and the downlink to the receiver are excluded from the observation. 

2 ODTK application configuration 

To accurately simulate TDOA and FDOA measurements, or to use TDOA and FDOA measurements 

for estimation, certain objects must be present and properly configured in the ODTK application. 

Processing of ground-based or space-based measurements of a ground-based emitter requires 

an Emitter object attached to a Facility object. You must specify the transmission frequency of 

the emitter to accurately model FDOA measurements and to accurately account for ionospheric 

effects on TDOA measurements. ODTK processing also uses the transmission frequency for tran-

sponder selection on the relay satellites during simulation of measurements and for transponder 
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selection during estimation if an explicit transponder ID is not specified in the tracking data. To 

simulate or process measurements, the two relay satellites must also be within the visibility con-

straints of the emitter and receiver. ODTK processing can estimate the location of a Facility host-

ing an Emitter if the location is not precisely known. 

2.1 Ground-based measurements 

The ODTK objects required for processing TDOA and FDOA measurements tagged at ground-re-

ceipt time are: an Emitter object, two Satellite objects equipped with relay transponders, and a 

Facility object as the signal receiver. The receiver facility does not need be under or within the 

same TrackingSystem object as the emitter. The MeasurementStatistics properties are associated 

with the receiver facility. Note that the “2R” versions of these measurement models are used 

when the signal paths end at different receive locations. 

Simulation of ground-based TDOA and FDOA measurements is based on the construction of 

tracking strands that start with the emitter, pass through the relay satellites of two different 

routes, and end at the receiver facility. Strands are possible for all emitters, all satellites hosting 

relay transponders, and all facilities with TDOA or FDOA measurement statistics. 

TDOA measurements depend on (bold indicates estimation is possible): 

• The location of the facility hosting the emitter 

• The troposphere and ionosphere settings of the facility hosting the emitter 

• The orbits, or trajectories, of the relays 

• The transponder delays of the relays 

• The troposphere and ionosphere settings of the receiver facility 

• The location of the receiver facility 

• A measurement bias 

ODTK processing can estimate the delay for each transponder and model two or more tran-

sponders on each relay satellite. Selection of the transponder for ODTK processing to use in a 

particular observation is based first on a transponder ID provided as part of the measurement 

(real data only) and secondly by the frequency of the emitter. By default, the ODTK application 

configures transponders to have a very large bandwidth to simplify construction of basic simula-

tions. Simulation and estimation do not model ground-system delays, so you must remove 

ground-system delays from observations when using two or more ground strands. However, 

when using a single ground strand, the receiver measurement bias can approximately compen-

sate for ground delay. 

FDOA measurements depend on (bold indicates estimation is possible): 
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• The location of the facility hosting the emitter 

• The frequency of the emitted signal 

• The orbits, or trajectories, of the relays 

• The frequency translation through the relay transponders 

• The location of the receiver facility 

In addition to TDOA and FDOA measurements, ODTK software can also process the time rate of 

change in TDOA (TDOA Dot), singly differenced TDOA, and singly differenced FDOA measure-

ments. ODTK software models TDOA Dot as the instantaneous time derivative of TDOA. Singly 

differenced TDOA and FDOA measurements are differences between the TDOA and FDOA meas-

urements for two emitters whose signals traverse the same two relay satellites, though possibly 

using different transponders, and are received at the same receiver facility. All of the descrip-

tions characterizing TDOA measurements above also apply to TDOA Dot measurements. 

2.2 Space-based measurements 

The ODTK objects required for processing space-based TDOA (SB TDOA) and space-based FDOA 

(SB FDOA) measurements tagged at satellite-receipt time are an Emitter object attached to a Fa-

cility and two Satellite objects. The satellite objects do not require relay transponders. The Meas-

urementStatistics properties are associated with one of the satellites. 

Simulation of SB TDOA and SB FDOA measurements is based on the construction of tracking 

strands that start with the emitter and end at two satellites. Strands are possible between all 

emitters and satellites providing one (or both) of the satellites has SB TDOA or SB FDOA Meas-

urementStatistics properties active. 

SB TDOA measurements depend on (bold indicates estimation is possible): 

• The location of the facility hosting the emitter 

• The troposphere and ionosphere settings of the facility hosting the emitter 

• The orbits, or trajectories, of the relays 

• A measurement bias 

Space-based measurements require that all ground delays and satellite transponder delays be 

removed. 

SB FDOA measurements depend on (bold indicates estimation is possible): 

• The location of the facility hosting the emitter 

• The frequency of the emitted signal 
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• The orbits, or trajectories, of the relays 

In addition to SB TDOA and SB FDOA measurements, ODTK software can also process the time 

rate of change in SB TDOA (SB TDOA Dot) as a measurement. SB TDOA Dot is modeled as the in-

stantaneous time derivative of SB TDOA. 

3 TDOA and FDOA tracking data 

The ODTK application can simulate ground-based and space-based TDOA, FDOA, and TDOA Dot 

measurements in the GEOLOC or generic-observation (gobs) format. It can also use these same 

data as input for estimation. The generic-observation format is a binary format that has the ben-

efit of maintaining the full precision of simulated measurements. It is only useful, however, for 

simulated measurements, since the format is not published. GEOLOC is a simple ASCII format 

that is documented as part of the ODTK help system and is therefore the best way to import real 

TDOA and FDOA measurements. ODTK software can also process singly differenced ground-

based TDOA and singly differenced ground-based FDOA measurements. There are two ways in 

which you can import the differenced measurements: directly via the GEOLOC format or indi-

rectly, where the difference measurements are computed from individual TDOA and FDOA meas-

urements upon loading into the ODTK application from either generic-observation or GEOLOC 

tracking data files. Processing single-difference measurements in this latter manner is the subject 

of one of the exercises below. 

4 Simultaneous orbit determination 

The ODTK application can regard the ephemerides of relay-satellites in different ways while pro-

cessing TDOA and FDOA measurements. 

• The relay satellite orbits may be simultaneously estimated with any unknown emitter 

locations. This is the recommended mode for processing ground-tagged measurements. 

In some cases, all emitter locations may be known, in which case, estimation of the or-

bits is the primary objective. Simultaneous orbit determination will significantly improve 

the orbit and covariance (at the expense of more solution time). 

• Reference ephemerides may be provided for the satellites, thus limiting estimation to 

emitter location(s) only. In the case of space-based measurements, an a priori estimate 

of the orbit is required to back up the observations to the time of satellite receipt. In 

this case, you have the option of using reference ephemerides (preferably the same 

ephemerides used in the construction of the measurement) or estimating the orbits 

while estimating the emitter location(s). 
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5 Sample TDOA and FDOA simulation 

The following procedure steps through a simple simulation of ground-based TDOA and FDOA 

tracking data. You will use ground-based TDOA and FDOA measurements to simultaneously esti-

mate two (2) satellite orbits and two (2) emitters with uncertain locations. You will also use data 

from three emitters with well-known locations. Due to the large amount of input required to ini-

tially set up such an exercise, you will import some of the required objects in a preconfigured sta-

tus via an ODTK demonstration scenario. 

1. Start the ODTK application. 

2. Load the GS_GeoLocation demonstration scenario located in your STK_ODTK install area 

under the directory: 

<Install_Dir>\ODTK\UserData\DemoScenarios\Geolocation with TDOA and FDOA Meas-

urements 

After loading the scenario, go to the File menu and perform a Save As operation to save 

a copy of the scenario to your local user area. 

3. You must use the expanded versions of the Earth Orientation Parameters (EOP) and 

Space Weather because the scenario epoch is outside of the range of the default file 

time span for these parameters. Double-click the Scenario object (TDRSSGettingStarted) 

to open its Properties window. Scroll down to EarthDefinition > EOPData > Filename. If 

the current file path is not C:\ProgramData\AGI\STK_ODTK 13\DynamicEarthData\EOP-

All-v1.1.txt, then click the file path and change it to this one. Also under EarthDefinition, 

go to FluxData > InputFluxFile. If the current file path is not C:\Pro-

gramData\AGI\STK_ODTK 13\DynamicEarthData\SpaceWeather-All-v1.2.txt, then click 

the file path and change it to this one. Click Apply to accept the changes and then close 

the Scenario Properties window. 

4. Check that the appropriate measurement statistics (TDOA, FDOA) exist under the "Mon-

itor" Facility object, which serves as the receiver facility for this example. 

5. Check the properties of each Emitter object. Each emitter has its own transmit fre-

quency, and the facilities hosting "unknown" emitters are configured for estimation of 

their locations.  

6. To simulate ground-based TDOA and FDOA measurements routed through the geosta-

tionary satellites, add transponders to each satellite and set each transponder type to 

"Relay". When the transponder type changes, new transponder attributes appear under 

a heading of RFInfo. The center frequency and bandwidth fields define the range of re-

ceived frequencies for this transponder. The default values, which are designed to cover 

all commonly used frequencies, are adequate for this exercise, but the modeling real 

systems will likely require that two or more transponders, each with its own frequency 

range, be added to the relay satellites. During the creation of simulated measurements, 

frequency-based selection is used to pick the correct transponder. During estimation, 
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ODTK processing first attempts explicit selection via the transponder ID with frequency-

based selection used if there is no transponder ID. AddFreqTranslation is the frequency 

translation that is added to the received signal in generating the downlink carrier fre-

quency. For example, if a ground signal is received at 14.3 GHz and a frequency transla-

tion of -2300 MHz is specified, the satellite transponder broadcasts the relayed signal at 

12.0 GHz. Use the default value of -2300 MHz for this exercise. 

7. Add a simulator object to the scenario and double-click it to open its properties. 

8. Under ProcessControl, change TimeStep to 2 minutes and change StopTime to “15 Jun 

2006 00:00:00.00 UTCG”. 

9. For Output > Measurements > Filename, make sure the file extension is for “Generic 

Simulation” (.gobs).  

10. Back near the top of the properties window, click next to the TrackingStrandList attrib-

ute of the simulator to bring up the list of assigned tracking strands, which should be 

empty. Remember, an empty tracking strand list means "use all strands." Click the Add 

button to view the list of available strands; you will see that only one strand is available. 

Cancel out of editing the TrackingStrandList. (Optional: Temporarily change one of the 

transponders to a type other than relay, then re-examine the available tracking strands 

for the simulator. Note that selecting the Add button no longer displays a selection win-

dow because no tracking strands are available. This is because simulation of ground-

based TDOA and FDOA measurements requires that the satellites have relay transpond-

ers. Change the transponder type back to relay.) 

11. Click Apply and close the Simulator Properties window. 

12. Run the simulation. This can take several minutes. The simulator initially perturbs the 

unknown emitter locations and the satellite initial conditions by a varying amount. 

13. Now add a Filter object to the scenario to perform orbit determination using the simu-

lated measurements. 

14. Double-click the Filter object to open its properties. Scroll down to Output > Smoot-

herData and change the Generate attribute to true. Click Apply and close the Filter Prop-

erties window. 

15. Select the Dynamic Product Selector from the View menu and create a dynamic Meas-

urement Update report for either of the satellites in the scenario. 

16. Run the Filter while monitoring the dynamic report. Once the filter appears to be run-

ning correctly, close the dynamic report window to allow the run to finish more quickly. 

This process can take several minutes to complete. 

17. When the filter is finished, examine its output using the Static Product Builder. Try using 

the “Residuals” graph style to view TDOA then FDOA residuals. Use the data-limiting se-

lections on the Inputs tab of the Static Product Builder to create separate graphs for 
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each measurement type. The TDOA residuals are reported in nanoseconds and the 

FDOA residuals are reported in Hz.  

18. Generate a “Position Uncertainty” graph containing information for both satellites. The 

data for the two satellites are almost identical because the satellites are close to each 

other in geostationary orbit and experience nearly identical tracking geometry. 

19. It is possible to difference the estimated state from the simulated truth state to see how 

closely the filter recovered the original simulated state. The first step in this process is to 

run the State Difference Tool (StateDiffTool.htm), which you can launch using the  

toolbar button. Select the filter output (.filrun) as the target file and the simulator out-

put (.simrun) as the reference file; these files will be located in your DataArchive direc-

tory. Click the Run button to generate the state-difference output. 

20. Now select the State Difference output (.difrun) as the data-source file for the Static 

Product Builder. On the Inputs tab of the Static Product Builder, limit reporting to the 

GEO_1 satellite only. Then generate the “Differenced Pos R”, “Differenced Pos I”, and 

“Differenced Pos C” graphs to see how the filter/simulator radial, in-track, and cross-

track position differences compare to the filter covariance. Change the data limiting on 

the Inputs tab to create the same graphs for the GEO_2 satellites to see those results. 

21. Change the data limiting for Facility Name on the Inputs tab of the Static Product Builder 

to show only information for the Unknown1 emitter. Now generate the “Differenced 

Fac Loc Topo” graph to see how well the Filter was able to recover the deviated loca-

tion. Generate the same graph and examine the results for the Unknown2 emitter. 

22. Now create a new smoother object. Assign the .rough file created by the filter as the in-

put for the smoother by adding it to the Input.Files list. 

23. Run the smoother. 

24. Run the State Difference tool again, this time using the smoother output (.smtrun) as 

the target file and the simulator output (.simrun) as the reference file. Select an output 

file name that will not write over your prior filter-simulator difference run should you 

want to compare the two results. 

25. Generate the “Differenced Fac Loc Topo” report for the Facility “Unknown1” using the 

new smoother-simulator difference output. The smoother does not improve the esti-

mate of the unknown emitter locations. Feel free to also examine the orbit differences, 

transponder delay differences, etc. 

26. Run the State Difference tool again, using the smoother output (.smtrun) as the target 

file and the filter output (.filrun) as the reference file. Select an output file name that 

will not write over your prior filter-simulator or smoother-simulator difference runs. 

27. Select the latest State Difference output file from Step 24 above (smoother minus filter) 

as the data-input file for the static product builder. Generate a “Position Consistency” 
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graph, then a “Facility Location Consistency” graph. Filter/smoother consistency tests 

are good indicators of the sufficiency of the adopted model. Ideally, 99% of the test-sta-

tistic values for each parameter should remain between -3 and 3. All parameters per-

form well in this simulation. 

28. Extra Credit: Configure and run the filter to process only TDOA measurements; then fil-

ter only FDOA measurements. Note the amount of time required in each case for the 

filter to significantly reduce the uncertainty in the emitter locations, and compare to the 

results when two data types were processed together. 

6 Sample SB TDOA and SB FDOA Simulation 

The following procedure steps through a simple simulation of space-based TDOA and FDOA 

tracking data tagged at the receipt time of the satellites. You will use space-based TDOA and 

FDOA measurements to simultaneously estimate two emitters with uncertain locations, given 

the reference ephemerides of the receiver satellites. You will also use data from three well-

known emitters. Due to the large amount of input required to initially set up such an exercise, 

you will import some of the required objects in a preconfigured status via another ODTK demon-

stration scenario. The space-based exercise is streamlined relative to the earlier ground-based 

exercise to point out the differences in the processing and to avoid redundant tasks. 

1. Start the ODTK application. 

2. Load the GS_GeoLocation_II scenario located in your ODTK install area under the direc-

tory: 

<Install_Dir>\ODTK\UserData\DemoScenarios\Geolocation with TDOA and FDOA Meas-

urements 

After loading the scenario, go to the File menu and perform a Save As operation to save 

a copy of the scenario to your local user area. 

3. Again, you must use the expanded versions of the Earth Orientation Parameters (EOP) 

and Space Weather because the scenario epoch is outside of the range of the default 

file time span for these parameters. Double-click the Scenario object (TDRSSGet-

tingStarted) to open its Properties window. Scroll down to EarthDefinition > EOPData > 

Filename. If the current file path is not C:\ProgramData\AGI\STK_ODTK 13\Dynam-

icEarthData\EOP-All-v1.1.txt, then click the file path and change it to this one. Also un-

der EarthDefinition, go to FluxData > InputFluxFile. If the current file path is not C:\Pro-

gramData\AGI\STK_ODTK 13\DynamicEarthData\SpaceWeather-All-v1.2.txt, then click 

the file path and change it to this one. Click Apply to accept the changes and then close 

the Scenario Properties window. 
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4. Check that the appropriate measurement statistics (SB TDOA, SB FDOA) exist in a Track-

ingInstrument under one of the satellite objects. In this example, the measurement sta-

tistics are associated with GEO_1. The measurement names are preceded by "SB", indi-

cating that they are space-based measurements. 

5. Check that both satellites are configured to use a reference trajectory ephemeris source 

(Satellite.EstimateOrbit is "false"). Verify that the reference trajectory refers to a file 

with "truth" in the filename. Verify that the CovarianceSource associated with the se-

lected reference trajectory is set to “None” indicating that the ephemeris will be consid-

ered to be without uncertainty. 

6. Run the simulator. This can take several minutes. 

7. Bring up the Dynamic Product Selector from the View menu and create a dynamic Meas-

urement Update report for either of the satellites in the scenario. 

8. Run the Filter. No updates appear because the filter is not estimating the satellite orbit. 

Close the dynamic report window to allow the run to finish more quickly. This process 

can take several minutes to complete. 

9. When the filter is finished, plot residuals and histograms for “SB TDOA” and “SB FDOA”. 

The “SB TDOA” residuals will be reported in nanoseconds and the “SB FDOA” residuals 

will be reported in Hz. Leave these plots open for a later comparison. 

10. Use the State Difference Tool to generate a Filter/Simulator difference run file, where 

the (.simrun) file is the reference file. 

11. Select the difference run (.difrun) output just created as the input file for the Static 

Product Builder. Generate the “Differenced Fac Loc Topo” graph to see how well the Fil-

ter was able to recover the deviated emitter locations. 

12. Create a new smoother object and double-click it to open its properties. For Input > 

Files, select the *.rough file created by the filter. Also Click Apply and close the 

Smoother Properties window. 

13. Run the smoother. Recall from the last exercise that the smoother did not provide any 

additional improvement relative to the filter result for station-location estimation, so 

the smoother output does not need to be examined directly. 

14. Generate a difference run using the smoother output (.smtrun) as the target file and the 

filter output (.filrun) as the reference file. Select a difference-output file name that will 

not write over prior difference run output. 

15. Using the new difference output file (filter/smoother) as the input to the static product 

builder, generate the “Facility Location Consistency” graph. Leave this plot open for a 

later comparison. 
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16. The filter and smoother that you just ran had an unfair advantage. Although the satellite 

orbits were not estimated, they were provided to the estimator without error. Now, 

change each satellite configuration to reference the supplied ephemerides having "ref-

erence" in the filename. The supplied reference ephemerides have one-sigma (1 σ ) er-

ror uncertainties of 10, 50, and 100 meters in the radial, in-track, and cross-track direc-

tions, respectively. 

17. Select a filter output file name that will not write over prior output. 

18. Run the filter. 

19. When the filter is finished, plot residuals and histograms for “SB TDOA” and “SB FDOA”. 

Compare these plots to the ones you generated using the truth ephemeris. There is a 

mild periodic pattern in the “SB FDOA” residuals plot; otherwise, the results compare 

favorably. 

20. Generate a new filter/simulator difference run using the output from the new filter run. 

21. Examine the errors in the emitter-location estimates relative to the filter covariance us-

ing the “Differenced Fac Loc Topo” graph. The errors are well outside the covariance 

bounds of the filter. This is the result of not accounting for the errors in the satellite 

ephemeris. Of course, you would not have the luxury of comparing against the truth 

when processing actual tracking data. 

22. Select a smoother output file name that will not write over prior output. 

23. Run the smoother. 

24. Generate a difference run using the smoother output (.smtrun) as the target file and the 

filter output (.filrun) as the reference file. Select a difference output file name that will 

not write over prior output. 

25. Using the new difference output file (filter/smoother) as the input to the Static Product 

Builder, generate the “Facility Location Consistency” graph. Since the test statistic for 

each parameter should remain between -3 and 3, 99% of the time, this plot indicates a 

modeling problem that could adversely affect the results of the estimation process. This 

indicates a need for highly accurate reference ephemerides to support emitter location 

estimation if the uncertainty in the reference ephemeris is ignored. 

26. Start Extra Credit: Investigate whether or not estimating satellite orbits can improve the 

results. In the following steps, you will estimate the satellite orbits to see if that can im-

prove your results. 

27. Change the EstimateOrbit settings on both satellites to true. 

28. Use the Initial State Tool to generate initial conditions for both satellites from the “refer-

ence” ephemeris files. Select the epoch for each set of initial conditions as the start time 

in the ephemeris file. 
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29. Redo steps 18-25. Does this simulation indicate possible improvement in results by esti-

mating the orbit? 

30. So, it appears that the uncertainty in the spacecraft is an important component of pro-

cessing the measurements. Is there a way to accommodate that uncertainty without 

adding the satellites to state space? We could associate uncertainty with the reference 

trajectories by either using a constant representation in the RIC or by using the formal 

uncertainty in the reference ephemeris file to compute additive deweighting of the 

measurements. This can be done by changing the ReferenceTrajectory.Covaraince-

Source setting on the satellite objects. This will improve our results somewhat, but is 

still provides an inadequate representation of the ephemeris errors since the correla-

tions  

7 Sample single-differenced TDOA and FDOA simulation 

The following procedure outlines the steps necessary to simulate nondifferenced (ND) ground-

based TDOA and FDOA tracking data and then process the data as single-differenced (SD) meas-

urements. In this case, all of the emitter locations will be known and the primary objective will be 

to estimate the orbits of the two relay satellites Due to the large amount of input required to ini-

tially set up such an exercise, you will import some of the required objects in a preconfigured sta-

tus via another ODTK demonstration scenario. 

1. Start the ODTK application. 

2. Load the GS_GeoLocation_SD scenario located in your ODTK install area under the direc-

tory:  

<Install_Dir>\ODTK\UserData\DemoScenarios\Geolocation with TDOA and FDOA Meas-

urements 

After loading the scenario, go to the File menu and perform a Save As operation to save 

a copy of the scenario to your local user area.  

3. Again, you must use the expanded versions of the Earth Orientation Parameters (EOP) 

and Space Weather because the scenario epoch is outside of the range of the default 

file time span for these parameters. Double-click the Scenario object (TDRSSGet-

tingStarted) to open its Properties window. Scroll down to EarthDefinition > EOPData > 

Filename. If the current file path is not C:\ProgramData\AGI\STK_ODTK 13\Dynam-

icEarthData\EOP-All-v1.1.txt, then click the file path and change it to this one. Also un-

der EarthDefinition, go to FluxData > InputFluxFile. If the current file path is not C:\Pro-

gramData\AGI\STK_ODTK 13\DynamicEarthData\SpaceWeather-All-v1.2.txt, then click 

the file path and change it to this one. Click Apply to accept the changes and then close 

the Scenario Properties window. 
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4. Examine the measurement statistics for the Monitor facility. Both SD and ND measure-

ment statistics are defined. The statistics for the SD and ND measurements are related 

via: 

𝜎𝑆𝐷 = √2𝜎𝑁𝐷
2  

5. Set the ReferenceEmitter property of the Monitor facility to point to the emitter named 

Reference. This step is required to support the generation of SD measurements when 

the filter is run. The SD measurements will be computed as TDOA or FDOA for each 

emitter minus the TDOA or FDOA for the reference emitter. The number of each type of 

SD measurement available at each time will therefore be one less than the number of 

ND measurements available at that time. 

6. Check the enabled MeasTypes on the simulator and filter objects. The simulator does 

not have the SD measurement types enabled, while the filter does not have the ND 

measurement types enabled. The simulator cannot simulate SD measurements directly. 

The inclusion of the ND measurement types in the simulator MeasTypes was, therefore, 

not necessary for proper execution, but was done for illustrative purposes. The filter will 

construct the SD measurements upon loading of the ND measurements if the following 

conditions are met: 

• SD measurements are specified in the MeasTypes for the filter or the MeasTypes 

list is empty. 

• SD measurements are specified in the MeasTypes for the satellites or the 

MeasTypes list is empty. 

• SD measurements are specified in the MeasurementStatistics for the receive facil-

ity. 

• A reference emitter is specified in the properties of the receive facility. 

7. Run the simulation. This may take several minutes.  

8. Bring up the Dynamic Product Selector from the View menu and create a dynamic Meas-

urement Update report for either of the satellites in the scenario.  

9. Run the Filter. Monitor the filter run using the dynamic report. Once you are satisfied 

that the filter is running correctly, close the dynamic report window to allow the run to 

finish more quickly. This process may take several minutes to complete. 

10. Generate “Residuals” graphs to view SD TDOA then SD FDOA residuals. The SD TDOA re-

siduals will be reported in nanoseconds and the SD FDOA residuals will be reported in 

Hz. Also generate residual histograms for each type of measurement. 

11. Generate a “Position Uncertainty” graph containing information for both satellites. The 

data for the two satellites is almost identical. This is due to the fact that the satellites 
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are close to each other in geostationary orbit and experience nearly identical tracking 

geometry. Leave this graph around for a later comparison. 

12. Generate a difference run using the filter output (.filrun) as the target file and the simu-

lator output (.simrun) as the reference file. Select an output file name that will not over-

write your prior difference runs. 

13. Use the difference output to generate the “Differenced Pos R”, “Differenced Pos I”, and 

“Differenced Pos C” graphs for each satellite. The differences lie mostly within the two-

sigma covariance bounds with exceptions mainly limited to the radial direction. Also 

note the increasing envelope of the in-track uncertainty. 

14. Assign the rough file created by the filter as the input for the smoother by adding it to 

the Input.Files list. 

15. Run the smoother.  

16. Generate a difference run using the smoother output (.smtrun) as the target file and the 

simulator output (.simrun) as the reference file. Select an output file name that will not 

overwrite your prior filter-simulator difference run if you would like to compare the two 

results. 

17. Use the difference output to generate the “Differenced Pos R”, “Differenced Pos I”, and 

“Differenced Pos C” graphs for each satellite. The excursions of the radial difference out-

side the two-sigma covariance bounds in the radial direction are more severe in the 

smoother result. The smoother appears to give good improvement in the in-track direc-

tion, but the uncertainty is still large. 

18. Generate a difference run using the smoother output (.smtrun) as the target file and the 

filter output (.filrun) as the reference file. Select an output file name that will not over-

write your prior filter-simulator or smoother-simulator difference runs. 

19. Using the new difference output file (filter/smoother) as the input to the static product 

builder, generate a “Position Consistency” graph. While the in-track and cross-track con-

sistency looks good, the radial consistency graph indicates a possible modeling problem. 

While it has not yet been proven, the current theory is that this inconsistency is the re-

sult of not accounting for the correlation between the single-differenced measure-

ments. 

20. Extra Credit: The effect of ignoring the correlation between the measurements is to tell 

the filter that it has more information on the orbits than it really does. We can partially 

compensate for this misinformation by increasing the noise on the measurements. Try 

increasing the noise on the single differenced measurements and rerunning the filter 

and smoother. Do the results appear to improve? How do the measurement residual 

plots and residual histogram plots look? 


